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1.Lwu y quan trong

Sé tay st dung dién t& nay danh cho moi
ngwdi dung st dung man hinh Philips. Hay
danh thai gian doc sé tay st dung nay trwde
khi str dung man hinh. Sé tay bao gém
nhirng thdng tin va cac lwu y quan trong lién
quan dén viéc str dung man hinh.

Ché d6 bao hanh cua Philips 4p dung véi
didu kién la san phdm phai dwoc st dung
dung cach theo muc dich st dung, theo céac
hwéng dan hoat ddng ciing véi viéc xuét
trinh héa don gbc hodc bién nhan tién mét
ghi rd ngay mua, tén ngwdi ban, mau ma va
ma sb san xuat cla san pham.

1.1 Lwu y an toan va bao dwéng

) Canh bao

S dung cac nut diéu khién, diéu chinh hoac
cac quy trinh khac ngoai cac quy trinh dwoc
néu rd trong tai liéu nay cé thé khién nguoi
duing dé& bij dién giat, gap cac rdi ro vé& dién
va/hoac co hoc.

Hay doc va thwe hién theo cac hwéng dan sau
khi két néi va str dung man hinh may tinh.

Hoat dong

+ Khéng dé& man hinh tiép xtc véi anh
sang mat trdi trwe tiép, anh sang rat
manh va cac ngudn nhiét khac. Viéc dé
tiép xdc lau véi loai médi trwdng nay cé
thé dan dén sy dbi mau va l1am héng
man hinh.

+  Di chuy&n moi dé vat c6 thé roi vao cac
16 théng gi6 clia man hinh hodc ngan
can qua trinh lam mat thich hop clia cac
thiét bi dién tlr bén trong man hinh.

+ Khéng bit kin cac 16 théng gié trén vd
man hinh.

« Dam bao d&t man hinh & gan noi cé
phich cdm va & cadm dién.

+ Néu tat man hinh bang cach rat cap
ngudn hodc day dién DC, hay doi 6 giay

trwée khi cdm cap ngudn hodc day dién
DC d& man hinh hoat déng binh thuong.
Hay luén dung cap ngudn chuan dwoc
cAp bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai dia
phwong ban. (Vui ldong tham khdo muc
Trung tdm théng tin tiéu dung cham séc
khach hang)

Khoéng dat man hinh & noi bi chén doéng
hay va cham manh khi dang hoat déng.
Khéng dap hoac lam roi man hinh khi
dang hoat déng hodc khi di chuyén.

Bao dwdng

D& man hinh khang bi hdng, khéng dé
nén qua manh Ién mat man hinh panel.
Khi di chuy&n man hinh, hay ndm chat
khung man hinh d& nhéc I&n; khéng nhac
man hinh bang cach dat ban tay hodc
ngoén tay Ién mat man hinh.

Rut phich cdm man hinh néu ban khéng
dinh sr dung no trong thoi gian dai.

Rt phich cdm man hinh néu ban can lau
chui man hinh bang mét miéng vai hoi
wét. Ban c6 thé lau man hinh béng vai
kho khi da ngéat dién. Tuy nhién, dirng
bao gi® diing dung madi hitu co, chdng
han nhw cdn hodc cac chét Idng cé
ngudn gbc t&r amoniac dé lau man hinh.
P& tranh nguy co bj dién giat hodc héng
vinh vién bd man hinh, khéng d&t man
hinh & noi cé bui, mwa, nwéc hodc & noi
qua dm uét.

Néu man hinh bi wét, hay lau né bang
vai khé cang sém cang tét.

Néu chét la hodc nwéc dinh vao man
hinh, hay ngat dién ngay va rat cap
ngudn. Sau d6 lau sach chat la hodc
nwéc rdi glri man hinh dén trung tam bao
dudng.

Khéng cét gir hodc st dung man hinh

& noi c6 ngudn nhiét, anh nang truc tiép
hoac qua lanh.

D& duy tri hoat dong téi wu ctia man hinh
va str dung né trong thoi gian dai, hay
dung man hinh & noi ndm trong gi¢i han
nhiét doé va dé &m sau.



o Nhiét do: 0-40°C 32-95°F
o Do dm: 20-80% RH

< LUWU Y: Ludn bat trinh bao vé man hinh
chuyén dong khi ban khéng s dung
man hinh. Luén bat (rng dung lam ma&i
man hinh dinh ky, néu khéng, man hinh
clia ban sé& hién thi nhirng néi dung tinh
khong thay dbi. Hién thj lién tuc cac anh
tinh trong moét thei gian dai cé thé gay ra
hién tweng "anh thir néng", con dwoc goi
la “anh do0” hay “anh bong ma”, trén man
hinh cta ban.

«  “Anh th&r néng”, “Anh &0” hay “Anh béng
ma” |a hién twong phd bién trong cong
nghé& man hinh monitor. Trong hau hét
cac treeong hop, hién twgng “anh thir
néng” hodc “anh ao0” hay “dnh béng ma”
sé dan dan bién mét sau mét thei gian
man hinh bi ngat dién.

) Canh bao

Cac hién twong “anh thtr néong” hay “anh ao”
hay “anh béong ma” sé& khong biét mét va ban
can mang man hinh di stra. Thiét hai nhw
trén khéng ndm trong chinh sach bao hanh
clia chung toi.

Dich vu

* Chinhan vién dich vu chuyén moén mgi
dwoc m@ voé boc man hinh.

«  Néu can moi tai liéu hwéng dan dé stra
chira hoac tich hgp man hinh, hay lién
hé v&i trung tdm dich vu tai dia phwong
ban. (vui Iong tham khao chwong "Trung
tdm théng tin tiéu dung")

+ D& biét thong tin vé viéc van chuyén, vui
long tham kh&o muc "Théng sb k thuat".

+ Khéng dat man hinh trong xe hoi/cdp xe
dwai anh néng truc tiép.

& Ghi chu

Hay tham khao y kién cla ky thuat vién
dich vu néu man hinh khéng hoat déng
binh thwéng hodc néu ban khéng chéc phai
thwe hién quy trinh nao khi da lam theo cac
hwéng dan hoat ddong néu trong sb tay nay.

1.2 M6 ta biéu twong

Céac muc phu sau day mé ta cac quy wéc vé
biéu tweng ding trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chir cé
thé di kém biéu twong va dwoc in dam hoac
in nghiéng. Cac doan nay bao gém cac ghi
chd, Iwu y hodc canh bdo. Ching duwoc st
dung nhuw sau:

© Ghichu

Biéu twong nay cho biét cac thong tin quan
trong va céac bi quyét giup ban tan dung tbt
hé théng may tinh.

O Luuy

Biéu twong nay cho biét cac théng tin gitp
ban biét cach tranh dwoc sw ¢ héng héc
tiém &n ddi voi phan clirng hodc mat di liéu.

) Canh bao

Biéu twong nay cho biét sw tdn thwong co
thé tiém an va gitp ban biét cach tranh dwoc
sw cd do.

Mét s6 canh bao co thé xuét hién & nhiéu
dinh dang va cé thé khéng di kém mét biéu
twong. Trong nhirng trwedng hop nay, cach
thire trinh bay cu thé ctia canh bao dé dwoc
quy dinh b&i co quan chirc nang lién quan.



1.3 Virt bé san pham va vat liéu déng goi

Thiét bj dién & dién ti bi virt b6-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used
electrical and electronic appliances, this
product may not be disposed of with normal
household waste. You are responsible

for disposal of this equipment through a
designated waste electrical and electronic
equipment collection. To determine the
locations for dropping off such waste
electrical and electronic, contact your local
government office, the waste disposal
organization that serves your household
or the store at which you purchased the
product.

Your new monitor contains materials that
can be recycled and reused. Specialized
companies can recycle your product to
increase the amount of reusable materials
and to minimize the amount to be disposed
of.

All redundant packing material has been
omitted. We have done our utmost to make
the packaging easily separable into mono
materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers
Your display is manufactured with high
quality materials and components which can
be recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.




2. Cai dat man hinh

2.1 Lap dit

El N6i dung g6i hang

=
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VGA (optional) DVI (optional)

El Lap chan dé

1. D&t man hinh ndm sip trén bé mat
mém min, cAn than dé tranh lam tray
xwéc hoac hdng man hinh.

2. Gilr chan dé man hinh béng ca hai tay
va lap chat chan dé vao tru de.

(1) Nhe nhang géan dé vao tru dé cho
dén khi chét khoa dé.

(2) St dung ngdn tay dé van chét vit
nam & dwdi day dé va gan chat dé
vao tru.




El Két néi véi PC

2.2 Str dung man hinh
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© DAu vao ngudn dién AC

© Diuvao VGA

© Diuvao DVI-D

O Khoa chéng trom Kensington

Két ndi voi PC

1. C&m chat cap ngudn vao mat sau
clia man hinh.

2. Tt may tinh va rat cap ngudn.

Cam cép tin hiéu man hinh vao 16
cam video & mat sau may tinh.

4. CAm cap ngudn ctia may tinh va cap
ngudn ctia man hinh vao 6 cam dién
gan do.

5. Bat may tinh va man hinh. Néu man

hinh hién thi hinh anh thi qua trinh
cai dat da hoan tat.

El Mb ta mat trwéc cha san pham
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o &8 |Thay ddi dinh dang hién thi.
&+ |Diéu chinh dd sang.
© | A V¥V Dé chinh menu OSD.
o © |Pé dbi ngudn nhap tin hiéu.
€@ |Thay ddi dinh dang hién thi.
Smartlmage Lite. C6 ba ché
®@ D |dd dé banlwa chon: Standard
(Chuan), Internet va Game.




El Mb ta menu Hién thj trén man hinh
Hién thi trén man hinh (OSD) la gi?

Hién thi trén man hinh (OSD) la mét tinh
nang c6é & moi man hinh cta Philips. N6 cho
phép nguwdi dung diéu chinh hoat déng clia
man hinh hodc chon cac chirc nang cla
man hinh truc tiép théng qua moét ctra s
hwéng dan hién thi trén man hinh. Mét giao
dién hién thi trén man hinh dé s dung dwoc
thé hién nhu sau:

197E3L

Picture Format een
LR 100
< L 50

Brightness

- Off

Setup

v

Hwéng dan co ban va don gian vé cac
nat diéu khién

Trong menu OSD minh hoa & trén, ngu&i
diing c6 thé nhan v 4 cac nit & g& mat
trwéc clia man hinh dé di chuyén con tré,
b&dm OK d& xac nhan lwa chon hoéc thay
déi.

Menu OSD

Duwai day la tdng quan vé& co ciu clia menu
Hién thi trén man hinh. Ban c6 thé s dung
co cAu nay lam théng tin tham khao khi
mudn thwe hién cac didu chinh khac sau
nay.

Main menu Sub menu

VGA
— Input [
DVI (

available for selective models)

Picture Format — Wide Screen, 4:3
— Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast — On, Off
Color Temperature — 6500K, 9300K
[— Color
sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
|— Language — English, Espaiol, Francais, Deutsch, ltaliano,

Portugués, Pycckuii, BRI, Turkge

| 05D Settings r— Horizontal — 0~100
— Vertical — 0~100
— Transparency — Of,1,2,3,4
L— OSD Time out — 55,105,205,305,60s
— Setwp — Auto
[~ H. Position — 0~100
[~ V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification ~ On, Off
— Reset — Yes, No
L— Information




El Théng bao vé dé phan giai

Man hinh nay dwoc thiét ké d& hoat dong téi
wu v&i dd phan giai gbc 1a 1366x768@60Hz.
Khi dwoc chinh sang d6 phan giai khac, man
hinh sé& hién thi mot thong bao: Hay dung do
phan giai 1366x768@60Hz dé cd két qua tdi
wu.

Ban c6 thé tat thong bao hién thi d6 phan
giai gbc tlr muc Setup (Cai dat) trong menu
OSD (Hién thi trén man hinh).

B Tinh nang vat ly

Nghiéng

2.3 Thao dé va chan dé

El Thao chan dé

Trwdc khi bat d&u thado d& man hinh, hay
thwe hién theo cac hwéng dan bén dudi
@& tranh 1am héng man hinh hodc gay tén
thwong cho ban.

1.D&t man hinh ndm sép trén bé mat min,
can than dé tranh lam trdy xwéc hodc
héng man hinh.

2. Théo dé ra khéi tru dé bang cach:
(1) St dung ngon tay dé néi long vit nam
& duoi day dé
(2) Nhe nhang di chuyén Ién va xuéng dé
nha chét khoa dé va kéo dé ra khoi
tru de.




El Thao dé

1.Ban c¢6 thé s dung tubc no vit dau det dé
dwa vao hai 16 nha trén nap day va nhe
nhang nang I&én nap day &n dé 14y ra.

2.Théo 4 dinh vit rdi thao dé ra khdi man
hinh.




3. T6i wu héa hinh anh

3.1 Smartimage Lite
B bélagi?

Smartimage Lite cung c&p cac chirc néng
cai d&t sdn gitp ban t6i wu hda man hinh dé
st dung cho cac kiéu ndi dung khac nhau,
linh hoat chinh d6 sang, d6 twong phan,
mau sic va do sac nét khi st dung thuc té.
Du lam viéc véi cac ng dung bang chir,
hién thj hinh anh hay xem video, Philips
Smartlmage Lite cling mang lai cho ban hiéu
qua man hinh téi wu nhét.

El Sao t6i phai can n6?

Ban mudn mét man hinh hién thj téi wu

moi kiéu ndi dung wa thich, phan mém
Smartimage Lite sé linh hoat chinh d¢ sang,
dé twong phan, mau sic va do sac nét khi
st dung thwc t& nham nang cao trai nghiém
xem man hinh cta ban.

E Cach hoat déng?

Smartlmage Lite la céng nghé ddc quyén
tién tién cda Philips vbn sé phan tich cac
ndi dung hién thj trém man hinh caa ban.
Dwa trén bdi canh str dung ma ban lya
chon, Smartimage Lite sé linh hoat cai tién
d6 twong phan, bao hda mau séc va do sic
nét ctia hinh anh dé cai thién néi dung dang
hién thi - tAt ca khi str dung thuc té chi voi
duy nh4t mét ct nhan nut.

Bl Cach bat chirc nang Smartimage Lite?

1. Nhan @) dé khéi dong menu OSD
Smartimage Lite;

2. Tiép tuc nhan B dé chuyén gitra
Standard (Chuén), Internet, Game.

3. Menu OSD Smartlmage Lite s& van hién
thi trén man hinh trong 5 gidy hoac ban
cling c6 thé nh&n “OK” d& xac nhan lya
chon.

4. Khi Smartimage Lite da duoc bat, bd cuc
sRGB sé ty dong tat. Dé ding sRGB,
ban phai t&t Smartimage Lite bang nat
@D & g& mat trwde ciia man hinh.

Trir khi dung nut B d& cudn xudng, ban
cling c6 thé nhén nut w a d& chon va nhén
“OK” dé xac nhan Iya chon va déng menu
OSD Smartimage Lite.



Cé ba ché do dé ban Iwa chon: Standard
(Chuan), Internet va Game.

@ SmartImage U

Standard

Internet

Standard (Chuén): Lam rd chir va giam
do6 sang gitp ban dé doc chir va bot méi
méat. Ché d6 nay tang dang k& sw rd rang
clia n6i dung chi¥ va hiéu suét khi ban
lam viéc v&i cac bang tinh, file PDF, cac
bai muc scan hodc cac rng dung van
phong khac néi chung.

Internet: C4u hinh nay két hop bao hoa
mau séc, linh hoat tang do twong phan
va sic nét dé hién thj anh chup va cac
hinh anh khac vé&i do rd ndi bat cling
mau séc sbng dong - tAt ca moi thir ma
khong hé cé diu vét clia mau séc nhat
va gia tao.

Game: Téng mach truyén dong dé& co
thoi gian dap (ng téi wu, gidm cac be

I& gai géc cho cac dbi twong di chuyén
nhanh trén man hinh, tang d6 twong
phan cho bd cuc sang va tbi, cAu hinh
nay mang lai cho nguwoi choi trai nghiém
choi game t6t nhat.

3.2 SmartContrast
El bélagi?

Coéng nghé dbc dao vén linh hoat phan tich
ndi dung hién thj va tw dong ti wu hoa ty &
twong phan ctia man hinh monitor d& mang
lai d6 rd nét va trai nghiém xem tbi wu, tang
murc dén nén dé hién thj nhirng hinh anh
sang ré hon, séc nét hon va séng ddng hon
hay gidm mirc d&n nén dé hién thi ré hinh
anh trén phong nén tbi.

El Sao t6i phai can né?

Ban mudn hién thi ndi dung rd nét cuing
cam giac thodi mai nhat khi xem moi loai
n6i dung. SmartContrast sé linh hoat chinh
do6 twong phan va mirc dén nén dé hién thi
nhirng hinh anh choi game hay video cuc
ré, sbng déng va sac nét hay hién thj noi
dung chi¥ rd rang dé doc cho cac trng dung
van phong. Bang cach giam viéc tiéu thy
dién clia man hinh, ban sé tiét kiem dwoc
chi phi n&ng lwong va kéo dai tudi tho cho
man hinh ctia ban.

El Cach hoat déng?

Khi ban bat ché d& SmartContrast, né sé
phan tich néi dung dang hién thj trong thuc
t& dé chinh mau sic va mat do dén nén.
Chtrc nang nay sé linh hoat tang dé twong
phan d& mang lai cho ban trai nghiém giai tri
tuyét voi khi xem video hoac choi game.



3.3 Philips SmartControl Lite

Phan mém SmartControl Lite m&i clia
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa &o tién dung. Céac diéu
chinh phtrc tap 14 nhirng gi thudc vé& qua
kh(r vi phAn mém than thién véi ngudi dung
nay s& hwéng dan ban qua viéc tly chinh do
phan giai, hiéu chinh mau, diéu chinh ddng
hd/géc pha, digu chinh diém trdng RGB
(Bé-Luc-Lam), v.v...

Trang bi cong nghé mai nhat vé thuat toan
I6i xC Iy va phan (ng nhanh, phan mém
chay bang anh dong b&t mat thuwong thich
véi Windows 7 nay sén sang nang cao trai
nghiém cuta ban v&i man hinh Philips!

H Ccai dit

+  Thuec hién theo chi din va hoan tat quy
trinh cai dat.

Ban c6 thé kh&i dong phan mém sau khi
hoan tat cai dat.

Néu mudn khéi dong sau, ban c6 thé
click phim t&t phadn mém trén man hinh
nén hodc thanh céng cu may tinh.

PHILIPS

44444

11

Wizard (Thuat si) kh&i dong lan dau

Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé ty dong vao
Wizard (Thuat s7) khéi déng 14n dau.
Thuét sT nay s& hwdng dan ban théng
qua viéc diéu chinh tirng buwdc vé hiéu
suat man hinh.

Sau nay ban ciing ¢6 th& vao menu Plug-
in (B4 sung) dé bat thuat si.

Ban c6 thé chinh cac tly chon khac qua
giao dién Standard (Chuén) ma khong
can thuat si.

8 smartcontrol

2 - Philps 22581 (CS30715000001) ()X,

SmartControl Lite PHILIPS

Wizard

Start Wizard



El Khéi dong bang giao dién Standard
(Chuén):

Menu Adjust (Diéu chinh):

Menu Adjust (Bi&u chinh) cho phép ban
chinh Brightness (D06 sang), Contrast
(D6 twong phan), Focus (Trong tam),
Position (Vi tri) va Resolution (B phan
giai).
Ban cé thé l1am theo chi dan va thwc hién
diéu chinh.
Lénh Cancel (Hay) sé hdi ngwoi dung
xem ho ¢é mudn hay tién trinh cai dat
hay khdéng.

B SmartControl 2 - Philips 22581 (C530715000001) ()X
SmartControl Lite PHILIPS

Brightness
@ smartControl 2 Philps 22581 (CS30715000001) {#)X

SmartControl Lite

PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais in
iohter image areas.
1. Raise the Contrast unti the numbers 1 and 2
longer visble.
the Contrast to make the
nd 3 reappear. The number 1
shoud remain barely Vb

Adjust
Brghtness
Contrast
Color AR
A
Focus —
N Contras 50
\ + - *
_ Postion
undo Reset
Options
“*
. Resolution
Help

12

8 smartContol

SmartControl Lite

Adjust
Brightness
Contrast
Color
y Focus”
AN
\g Postion
Options
W
, Resolution
Help
B smartControl

SmartControl Lite

Adjust
Brghtness
Contrast
Color A
" Focus

N
e &
Options o
e
!\ Resolution

Help

8 smartcontrol

SmartControl Lite

Adiust
arghtness
Contrast
Color Y
AR
. Foaus
PACN
\g Positon
Options ﬁ
. Resolution
Hep

2 - Philps 22581 (CS30715000001) (%)X,
PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal

to Setup.

3 2l bands are stil visble, you'l need
to adjust the Pitch

Pitch: Try to make the

Phase: Adjust to the b

movement on the screen.

bands dssppear.
setting to mnimze

pich 50

= +

phase 17

= +
undo Auto Setup

2 - Philips 22581 (C530715000001) {Z]\X

PHILIPS

Position

fon buttons to center the mage on
sing this £0ol, you can postion the image
, or right.

e the Up/Down buttons to center the image
vertialy.

Use the Left/Right buttons to center the image
horiontaly.

undo Reset

2 Philps 22581 (CS30715000001) {#)X
PHILIPS

Resolution

You are currently at 2 Preferred resolution. For your

1 your diplay i at 2 Non-Preferred rest ick
on the Preferred button to change your resolution to
preferred.

I™ Enable Resokution Notifer

Picture Format.
I 4:3 aspect ratio

|
I




Menu Color (Mau):
Menu Color (Mau) cho phép ban chinh
mau RGB (Pé-Luc-Lam), Black Level
(D6 t6i), White Point (Diém tréng),
Color Calibration (Hiéu chinh mau) va
Smartimage Lite (Vui long tham khao
muc Smartlmage Lite).

Ban cé thé lam theo chi dan va thwc hién

diéu chinh.

Tham thdo bang bén dwéi d& hinh dung
co ban v& muc menu phu trén théng tin

nhap cda ban.

Vi du Color Calibration (Hiéu chinh mau

s&c).
8 smarControl

SmartControl Lite

4 1l
Adjust RGB
i
Biack Level
Color int
e
\g Display Gamma
= -yl
Options. Calibration
L @p
\ Smartimage
3
Help
18 SmartControl

SmartControl Lite

Adjust lRHGlB

\g .
Color Whi ‘a Point.

. )
\@ Display Gamma

e w

. ap
\ﬂ Srmartimage
Help
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Black Level

Undo Reset

2 phips 22581 (cs30715000001) (7]
PHILIPS

White Point

White Point 6500K

undo Reset
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8 smartconeol

SmartControl Lite

Display Gamma

w
Adjust RGE.
sk Love
Color White Point Display Gamma 22
S +
=
\Q Oy Gamma
- -
Options. Calibration gt i
Y ap
\ srmartinage
Help
 smarconao 2-vnips 22581 (L0 15000001) LI

SmartControl Lite PHILIPS

Calibration

Adjust
Color
-\
\ Oty Gamma
> gl
Options. Calbration
153
N a
\ sretiiese
Help
show e stat
Quick View

"Show Me (Cho t6i xem)" sé bat hwéng
dan hiéu chinh mau.

Start (B4t dau) - b4t d3u quy trinh canh
chinh mau qua 6 buwéc.

Quick View (Xem nhanh) tai cac hinh
anh trvéc/sau.

Tré vé& giao dién chinh Color (Mau),
click nat Cancel (Huy).

Enable color calibration (Bat hiéu chinh
mau) - theo méc dinh 1a dwoc bat. Néu
khéng chon muc nay, ban khéng dwoc
phép hiéu chinh mau va tit cac nut khéi
ddng va xem nhanh.

Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.



Man hinh hiéu chinh mau dau tién:

« Nut Previous (Truéc) sé tat cho dén khi
man hinh mau th hai bat Ién.

+  Next (K& tiép) sé& chuyén vao muc tiéu
tiép theo (6 muc tiéu).

+ K& tiép cubi cung sé vao giao dién File >
Presets (File > Cai sén).

« Nut Cancel (Huy) sé dong giao dién
nguwoi ding (Ul) va tré vé trang bd sung.

Smartimage Lite

Cho phép nguoi dung thay dbi cai dat dé dat
mrc cai d&t man hinh tét hon dwa vao ndi
dung.

Khi da cai dat Entertainment (Giai tri), tinh
nang SmartContrast va SmartResponse sé
tat.

8 SmartControl )

SmartControl Lite PHILIPS

SmartImage

sm:
o

Adiust 43

Black Level

Color White Pont
> [
\/ Display Gamma
-
Options Galbration
=
ap
srarinage =

Help

Internet.

Options > Preferences (Tuy chon >

Wu tién) - Sé chi hoat déng khi chon
Preferences (Uu tién) t&r menu Options (Tuy
chon) s6 xuéng. Trén man hinh khong hd
tro twong thich voi chuén DDC/CI, chi cé
s&n céac thé Help (Tro gitp) va Options (Tuy
chon).

B SmartControl 2- Philps 22581 (C530715000001) ()X

SmartControl Lite PHILIPS

Preferences

e folow

i

Adiust Audio

U

Color Tnput

W ie

Optons Presets

®

Help

« Hién thi cac cai dat wu tién hién hanh.

+ O vlra chon sé& bat tinh nang nay. O chon
la nt bat/tét.

+ Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh) hién
thi cac lwa chon SmartControl Lite cho
Select Preset (Chon cai sén) va Tune
Display (Chinh man hinh) trén menu
thudc tinh click phai vao man hinh nén.
Disabled (D3 t4t) sé x6a SmartControl
Lite khdi menu thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat khay

tac vy) dwoc chon la (Bat) theo mac
dinh. Menu bat thudc tinh hi&n thi menu
khay tac vu cho SmartControl Lite.
Click phai vao biéu twong khay tac vu
sé& hién thj cac tuy chon menu cho Help
(Tre gitip), Technical Support (H6 tro kj
thuat), Check for Update (Kiém tra cap
nhat), About (V&) va Exit (Thoat). Khi
da tat Enable task tray menu (Menu bat
khay tac vu), biéu twong khay tac vu sé
chi hién thj EXIT (THOAT).



Theo mac dinh Run at Startup (Chay khi
kh&i dong) sé dwoc chon la (BAT). Khi
d t&t, SmartControl Lite s& khong bat khi
kh&i ddng hodc ndm trong khay tac vu.
Cach duy nhét dé bat SmartControl Lite
14 tlr phim tat trén man hinh nén hodc ti
file chwong trinh. B4t ky bo cai d&t sén
nao dé chay khi kh&i dong sé hoat déng
khong tai khi 6 nay khéng dwoc chon (BPa
tat).

Enable transparency mode (Bat ché do
trong subt) (Windows 7, Vista, XP). Méc
dinh 1a 0% M.

Options > Input (Tuy chon > Nhap) - Sé
chi hoat déng khi chon Input (Nhap) tw
menu Options (Tuy chon) s6 xuéng. Trén
man hinh khéng hé tro twong thich vdi
chuan DDC/CI, chi c6 sén cac thé Help (Tro
gitp) va Options (Tuy chon). T4t ca cac thé
SmartControl Lite khac d&u khéng co sén.

W smartcontrol ooo0n) (7).

2 - Phips 22581 (CS30715¢
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SmartControl Lite

Adiust -9\’

]
\g Auto Phot
—

Color Tnput

Y %

> 2
Option: Presets

Digital In

+ Hién thi giao dién huéng dan Source
(Ngudn) va cai dat ngudn nhap thong tin
hién hanh.

Trén cac man hinh nhép riéng, giao dién
nay sé khong hién thj.

15

Options > Audio (Tuy chon > Am thanh) -
Sé& chi hoat dong khi chon Audio (Am thanh)
tir menu Options (TUy chon) sb xudng.

Trén man hinh khéng hé tro twong thich vai
chuén DDC/CI, chi c6 sén cac thé Help (Tro
giup) va Options (Tuy chon).

W smartcontol

00001) (R)X

SmartControl Lite PHILIPS

Audio

Help > User Manual (Tro gitGip > S6 tay
str dung) - Sé chi hoat déng khi chon User
Manual (Sb tay st dung) t&» menu Help (Tro
gitip) s& xudng. Trén man hinh khéng hé
tro twong thich voi chuén DDC/CI, chi co
sén cac thé Help (Tro giup) va Options (Tuy
chon).

8 smartcontol 81 (cs30715000001) ()X

SmartControl Lite PHILIPS

Adil
User@uua\
2
Color u
" Dsplay D
g

Tech. Support



Help > Version (Tro’ gitip > Phién ban) -
Sé chi hoat dong khi chon Version (Phién
ban) t& menu Help (Tro gilp) s xudng.
Trén man hinh khéng hé tro' twong thich véi
chuén DDC/CI, chi c6 sén cac thé Help (Tro
giup) va Options (Tuy chon).

W Smartcor ntrol 2 - Phiips 22581 (CS30715000001) (F] X

SmartControl Lite PHILIPS

Version

Menu nhay cam vé&i thudc tinh

Theo mac dinh Context Sensitive Menu
(Menu nhay cam v&i thudc tinh) sé dwoc
bat. Néu da chon Enable Context Menu (Bat
menu thudc tinh) trong giao dién Options >
Preferences (Tuy chon > Uu tién), thi menu
nay sé hién thi.

g SmartControl

Select Preset 13

Menu thudc tinh ¢é bdn muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé& hién th.

+ Select Preset (Chon cai dat sin) - Cung
cAp menu cac muc cai sdn da lwu theo
trinh tw dé& s dung ngay. DAu kiém sé
hién thi muc cai s&n hién da chon. Muc
cai san gdc ciing cé thé dwoc chon tir
menu sb xuéng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+ Smartlmage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu béng
céach click phai vao biéu twgng SmartControl
Lite tr khay tac vu. Click trai sé bat (rng
dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Tro giup) - Truy cap file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay s dung) qua clra s6
trinh duyét mac dinh.

+ Technical Support (H5 trg ki thuat) - hién
thi trang hd tro k§ thuat.

«  Check for Update (Kiém tra cap nhat) -
dan nguwoi dung dén Nén (ng dung PDI
va kiém tra phién ban clia ngwdi diing so
v&i phién ban cé sdn méi nhat.

+  About (V&) - Hién thij théng tin tham khao
chi tiét: phién ban san pham, thong tin vé
phién ban va tén san pham.

« Exit (Thoat) - Bong SmartControl Lite.

16



pé chay lai SmartControl Lite, hdy chon
SmartControl Lite tt* menu Chwong trinh,
click déi biéu twong PC trén man hinh nén
ho&c kh&i dong lai hé théng.

Smart

PHILIPS

SmartControl
Version 3.20
eltune-standard-R2007-01-04-1151-23
Copyright 1883-2007 Portrait Displays, Inc.
Patents Pending

P4 tat menu khay tac vu

Khi da tat Khay tac vu trong thw muc wu
tién, chi con co sdn lwa chon EXIT (THOAT).
Dé x6a hoan toan SmartControl Lite khoi
khay tac vu, hay tat Run at Startup (Chay khi
khéi déng) trong Options > Preferences (Tuy
chon > Uu tién).

17



4. Cac théng soé ky thuat

Hinh anh/Man hinh

Loai man hinh monitor TFT-LCD

Deén nén LED

C& man hinh 18,5 inch (47,0 cm)
Hé sbé co 16:9

Do pixel 0,3x 0,3 mm

Do sang 250 cd/m?

Do twong phan thong minh 20.000.000:1

Do twong phan (chuan) 1000:1

Thoi gian nhay (chuan) 5ms

1366x768 @ 60Hz

Gobc xem

170° (H) / 160° (V)@CIR > 10

Cai tién hinh anh

Smartimage Lite

DAu vao tin hiéu

Mau man hinh 16,7 triéu

Tbc d6 phat doc 56Hz -76Hz
Tan sb ngang 31kHz - 83kHz
sRGB (Pé-Luc-Lam chuan) | CO

DVI-D (KTS), VGA (Analog)

Tin hiéu vao

Tién ich cho ngwoi dung

Doéng bo riéng, Bdng bd véi tin hiéu xanh luc

197E3L: /Y ©/A /< a/k O
197E3L (1A): &p/v  E9/a  O/€ s/k O

Ngén ngir OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Btrc, Tiéng Y, Tiéng Nga,
Tiéng Tay Ban Nha, Tiéng Hoa Gian thé, Tiéng B6 Pao
Nha, Tiéng Thd Nhi Ky

Tién ich khac

Khoa Kensington

Twong thich véi chuan Plug
& Play (C&m vao la phat)

Nghiéng

DDC/CI, sRGB, Windows 7, Mac OSX, Linux

-5/+20
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Ché do bat

12,91W (chuan), 13,59W (t6i da)

Tiét kiém nang lvong

Dién ap dau vao

Dién ap dau vao

Dién ap dau vao

(Phwong phap thtr nghiém AC v@i cong AC v&i cong AC véi cong

EnergyStar 5.0) suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, +/-5VAC, +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Hoat dong thong thuwong 10,05W 9,96W 9,97W

(chuan)

Ché d6 ngu (chd) 0,5W 0,5W 0,5W

Tat 0,5W 0,5W 0,5W

Tan nhiét* Dién 4p dau vao | Dién ap dau vao | Dién ap dau vao
AC v&i cong AC v&i cong AC v&i cong
suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, +/-5VAC, +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Hoat déng thdng thuwdong

30,304 BTU/gi&

34,008 BTU/gi&

34,024 BTU/gio

Ché dd nga (cho)

1,706 BTU/gior

1,706 BTU/gio

1,706 BTU/gid

Tat 1,706 BTU/gi> | 1,706 BTU/gi> | 1,706 BTU/gi®y
Dén bao LED nguén Ché d6 bat: Trdng, Cho/Ngu: Tréng (Nhap nhay)
Bd ngudn Thir ndng,100-240VAC, 50-60Hz

San pham kém theo dé gitr
(Rong x cao x day)

462 x 364 x 200 mm

San pham khong kém theo dé
gilr (Rong x cao x day)

462 x 295 x 41 mm

dong)

San pham kém theo dé gitr 2,63 kg

San pham khong kém theo 2,194 kg

dé gitv

San pham déng goi 3,724 kg
Pham vi nhiét do (hoat dong) | 0°C - 40°C
Pham vi nhiét d6 (Khéng hoat | -20°C - 60°C

Do am twong doi

20% - 80%

Po6 cao

doat dong: + 365.760.00 cm (3.658 m)

Khéng hoat dong: + 40.000 foot (12.192 m)

MTBF (Th&i lwgng trung binh
gitra cac sw cd)

30.000 gior
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Chi thi ROHS (Gi¢i han cac | CO
chat gay hai)

EPEAT (Cong cu dang gia moi| Bac. (www.epeat.net)
truong cho san pham dién tlr)

Thung dwng Co thé tai ché 100%

DAu CE, FCC Loai B, GOAST, SEMKO, TCO Certified,
UL/cUL, BSMI, 1SO9241-307, Energy star 5.0

Phé chuan theo quy dinh

Mau Den (sau) / Xanh (trwéc)
L&p son ngoai Do béng
© Ghichu

1. Vang hay bac EPEAT chi ¢6 hiéu luc tai noi ma Philips da d&ng ky san pham. Hay truy
cap www.epeat.net dé biét tinh trang dang ky tai quéc gia cta ban.

Dt liéu nay chiu sy thay ddi ma khéng can théng bao truéc. Truy cap www.philips.com/
support dé tai v& phién ban td roi méi nhét.

N



4.1 Ché do dé phan giai & cai dat sén

Cho 197E3L
1366 x 768 & mirc 60 Hz (d4u vao
analog)

1366 x 768 & mirc 60 Hz (d4u vao KTS)

E1 D6 phan giai khuyén dung

Cho 197E3L
1366 x 768 & mirc 60 Hz (dau vao KTS)

31,47 720x400 70,09
31,47 640x480 59,94
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
47,71 1366x768 59,79
& Ghichu

Xin lwu y rdng man hinh clia ban hoat déng
tbt nhat & do phan giai 1366 x 768@60Hz.
Dé c6 chét lwgng hién thi tbt nhat, hay st
dung dé phan giai khuyén nghi nay.
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5.Quan ly nguon dién

5.1 Tiét kiém dién tw dong

Néu ban da cai dt card man hinh hay phan
mém twong thich chuan VESA DPM vao PC,
man hinh co thé tw doéng gidm tiéu thy dién
khi khéng st dung. Néu phat hién nhap tir
ban phim, chudt hay thiét bi nhap khac, man
hinh sé "hoat dong" tw dong. Bang sau day
sé& hién thi mirc tiéu thu dién va cach truyén
tin hiéu cua tinh néng tiét kiem dién tw dong
nay:

197E3L

Ché do| Video | Péng | Péng |Ngudn dién st dung| Mau dén
VESA bod | bo doc LED

ngang
Hoat | BAT Co Co <12,91 W (chuan) | Tréng
dong

Ngt | TAT [Khéng| Khéng <0,5W Trang
(Cho) (Nhép
nhay)

T& | TAT | - - <05W TAT

Cai dat sau day dwoc dung dé do murc tiéu
thu dién trén man hinh.

D phan giai gbc: 1366 x 768

Do twong phan: 50%

B9 sang: 250 nit

Nhiét do6 mau: 6500k vé&i kiéu mau trang day
da

& Ghichu

Dir liéu nay chiu sw thay ddi ma khong can
théng bao trwdc.
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6. Thong tin quy dinh

Lead-free Product

Lead free display promotes

@ environmentally sound recovery
IRy and disposal of waste from

electrical and electronic

equipment. Toxic substances like Lead

has been eliminated and compliance

with European community’s stringent

RoHs directive mandating restrictions on

hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

Congratulations,
Your display is designed for both you and
the planet!

The display you have just
‘lﬁ purchased carries the TCO
e f Certified label. This ensures

that your display is designed,
manufactured and tested according to some
of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact
on the climate and our natural environment.

TCO Certified is a third party verified
program, where every product model

is tested by an accredited impartial test
laboratory. TCO Certified represents one
of the toughest certifications for displays
worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are luminance,
contrast, resolution, black level, gamma
curve, colour and luminance uniformity
and colour rendering

» Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions
as low as normal household background
levels

» Low acoustic noise emissions (when

applicable)

Some of the Environmental features of
the TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system
(EMAS or ISO 14001)

* Very low energy consumption both in
on- and standby mode minimize climate
impact

» Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance)

» Both product and product packaging is
prepared for recycling

» The brand owner offers take-back options

The requirements can be downloaded from
our web site. The requirements included

in this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all
over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more
user-friendly direction. Our labeling system
started with displays in 1992 and is now
requested by users and ITmanufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit
WWW. velopment.com

For displays with glossy bezels the user
should consider the placement of the display
as the bezel may cause disturbing reflections
from surrounding light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic
Qe? Product Environmental
< Assessment Tool) program
evaluates computer desktops,
laptops, and monitors based on 51
environmental criteria developed through an
extensive stakeholder consensus process
supported by US EPA.
EPEAT system helps purchasers in the
public and private sectors evaluate, compare
and select desktop computers, notebooks
and monitors based on their environmental
attributes. EPEAT also provides a clear
and consistent set of performance criteria
for the design of products, and provides
an opportunity for manufacturers to secure
market recognition for efforts to reduce the
environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste
EPEAT’S requirement that all registered
products meet ENERGY STAR’s energy
efficiency specifications, means that
these products will consume less energy
throughout their life.

CE Declaration of Conformity

This product is in conformity with the

following standards

+  EN60950-1:2006 (Safety requirement of
Information Technology Equipment)

» EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)

» ENb55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment)

»  ENG61000-3-2:2006 (Limits for Harmonic
Current Emission)

+ EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable

2006/95/EC (Low Voltage Directive)

* 2004/108/EC (EMC Directive)

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive

for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on ISO9000
level.

The product also comply with the
following standards

1IS09241-307:2008 (Ergonomic
requirement, Analysis and compliance
test methods for electronic visual
displays)

GS EK1-2000:2009 (GS mark
requirement)

prEN50279:1998 (Low Frequency
Electric and Magnetic fields for Visual
Display)

MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields)
TCO certified (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO:
Swedish Confederation of Professional

Employees) for TCO versions

.

Energy Star Declaration
(www.energystar.gov)
PZ==N Asan ENERGY STAR® Partner,
”\‘“1‘(' we have determined that this
sy product meets the ENERGY
STAR® guidelines for energy
efficiency.

& Note
We recommend you switch off the monitor
when it is not in use for a long time.

24



Federal Communications Commission
(FCC) Notice (U.S. Only)

© This equipment has been tested and
found to comply with the limits for a
Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits
are designed to provide reasonable
protection against harmful interference
in a residential installation. This
equipment generates, uses and can
radiate radio frequency energy and, if
not installed and used in accordance
with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined
by turning the equipment off and on,
the user is encouraged to try to correct
the interference by one or more of the
following measures:

* Reorient or relocate the receiving
antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible
for compliance could void the user's
authority to operate the equipment.

Use only RF shielded cable that was
supplied with the monitor when connecting
this monitor to a computer device.

To prevent damage which may result in
fire or shock hazard, do not expose this
appliance to rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS
MEETS ALL REQUIREMENTS OF THE
CANADIAN INTERFERENCE-CAUSING
EQUIPMENT REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products
Marked with FCC Logo,

United States Only

FC

This device complies with Part 15 of the
FCC Rules. Operation is subject to the
following two conditions: (1) this device
may not cause harmful interference, and
(2) this device must accept any interference
received, including interference that may
cause undesired operation.

25



Commission Federale de la
Communication (FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des régles de la FCC. Ces
limites sont congues de fagon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre
d'une installation résidentielle.
CET appareil produit, utilise et peut
émettre des hyperfréquences qui, si
I'appareil n'est pas installé et utilisé
selon les consignes données, peuvent
causer des interférences nuisibles aux
communications radio.
Cependant, rien ne peut garantir
I'absence d'interférences dans le cadre
d'une installation particuliére. Si cet
appareil est la cause d'interférences
nuisibles pour la réception des signaux
de radio ou de télévision, ce qui peut étre
décelé en fermant I'équipement, puis
en le remettant en fonction, I'utilisateur
pourrait essayer de corriger la situation
en prenant les mesures suivantes:

» Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'équipement sur un autre
circuit que celui utilisé par le récepteur.

» Demander I'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas regu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur l'usage du
présent équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA
CLASSE B RESPECTE TOUTES LES
EXIGENCES DU REGLEMENT SUR LE
MATERIEL BROUILLEUR DU CANADA.

EN 55022 Compliance (Czech Republic
Only)

This dewvice belongs to catagory B devices as described in EM 55022, unless it is specrli-
cally stated that it is a Class A devics on the specification labal. The following applies to
devicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of tha
devics is obliged to taks all staps necessery to remove sources of intarference to tals-
communication or other devicas.

Pakud neni na typovém &titku poditade uvedeno, Ze spadé do do fidy A podle EN 55022,
spadé automaticky do tidy B podie EN 55022, Pro zafizen zafazend do tfidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudeni telekomunikatnich nebo
Pnych zafizeni je ufivatel povinmen provést takovd opatfgnl, aby rudeni odstranil.
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Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit
(a three-prong socket). All equipment that
works together (computer, monitor, printer,
and so on) should have the same power
supply source.

The phasing conductor of the room's
electrical installation should have a reserve
short-circuit protection device in the form of
a fuse with a nominal value no larger than
16 amperes (A).

To completely switch off the equipment,

the power supply cable must be removed
from the power supply socket, which should
be located near the equipment and easily
accessible.

A protection mark "B" confirms that the
equipment is in compliance with the
protection usage requirements of standards
PN-93/T-42107 and PN-89/E-06251.

Wymagania Pelskiege Centrum Badan i Certyfikacji

Hstwa

North Europe (Nordic Countries)
Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT
HUVUDBRYTARE OCH UTTAG AR
LATATKOMLIGA, NAR DU STALLER DIN
UTRUSTNING PAPLATS.

Placering/Ventilation
ADVARSEL:

SORG VED PLACERINGEN
FOR, AT NETLEDNINGENS STIK
OG STIKKONTAKT ER NEMT
TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA
VERKKOJOHTO VOIDAAN
TARVITTAESSA HELPOSTI IRROTTAA
PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES,
MA DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

EEE i




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor
entspricht den in der "Verordnung Uber den
Schutz vor Schaden durch Réntgenstrahlen”
festgelegten Vorschriften.

Auf der Riickwand des Gerates befindet sich
ein Aufkleber, der auf die Unbedenklichkeit
der Inbetriebnahme hinweist, da die
Vorschriften Uber die Bauart von
Storstrahlern nach Anlage Ill & 5 Abs. 4 der
Roéntgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der
Zulassung geforderten Werten entspricht, ist
darauf zu achten, daly

1. Reparaturen nur durch Fachpersonal

durchgeflihrt werden.

nur original-Ersatzteile verwendet
werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird
empfohlen, die Grundfarben Blau und

Rot nicht auf dunklem Untergrund zu
verwenden (schlechte Lesbarkeit und
erhdhte Augenbelastung bei zu geringem
Zeichenkontrast waren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAR NETZSTECKER UND
NETZKABELANSCHLUR LEICHT

[A)

ZUGANGLICH SIND.

China RoHS

The People's Republic of China released

a regulation called "Management Methods
for Controlling Pollution by Electronic
Information Products" or commonly referred
to as China RoHS. All products are produced
and sold for China market have to meet
China RoHS request.
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7.Dich vu cham séc khach
hang va bao hanh

7.1 Chinh sach 16i diém anh man hinh
phang cua Philips

Philips c6 géng cung cAp cac san pham chat
lwong cao nhat. Chang t6i ap dung moét sé
quy trinh sdn xuét tién tién nhat trong linh
vire va thuc hién quy trinh kiém tra chat
lweng nghiém ngét. Tuy nhién, cac 16i diém
anh hay diém anh con trén man hinh monitor
TFT dung trong cac man hinh phéng déi khi
khéng thé tranh khéi. Khéong nha san xuét
nao cé thé dam bao rdng moi man hinh sé
khoéng co cac 16i diém anh, nhwng Philips
dam bao réng bat ky man hinh nao cé mét
s6 16i khong thé chap nhan sé dwoc siva
chira hoac thay m¢i dwa vao chinh sach
bdo hanh. Théng bao nay giai thich nhirng
kiéu 16i diém anh khac nhau va dinh nghia
cac mtrc 18i co thé chap nhan cho mdi kidu
16i. D& hwéng dich vu stra chira hay thay
thé trong chinh sach bao hanh, sé lwgng 16i
diém &nh trén man hinh monitor TFT phai
vuot qua cac mirc chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bij 16i. Ngoai ra, Philips tham
con dat ra cac tiéu chuan chét lwong cao
hon cho mét sé kiéu hay két hop 16i diém
anh vén dé nhin thdy hon cac kiéu 16i khac.
Chinh sach nay c6 hiéu lwc trén toan cau.

subpixel subpixel subpixel

oy
il B

Diém anh va diém anh con

Diém anh hay phan tir anh gém ba diém
anh con trong cac mau chinh dé, luc va lam.
Nhiéu diém anh cling tao thanh hinh anh.
Khi moi diém anh con ctia mot diém anh
sang |én, ba diém anh con c6 mau sic cung
hién thi nhw mot diém anh trdng don 18. Khi
moi diém anh con t6i m&, ba diém anh con
¢6 mau sac cung hién thi nhu mét diém anh
den don I&. Nhitng két hop diém anh con
sang va t6i khac hién thi nhw cac diém anh
don Ié tir nhirng mau khac.

Cac kiéu 16i diém anh

Céac 16i diém anh va diém anh con hién thj
trén man hinh theo nhirng cach khac nhau.
Cé hai kiéu 16i diém anh va nhiéu 16i diém
anh con trong méi kiéu 16i.

Cac 16i cham sang

Cac 16i cham sang hién thi dwdi dang cac
diém anh hay diém anh con vén luén sang
hay 'bat'. Nghia la mdi chAm sang 1a mét
diém &nh con vén ndi 1&n trén man hinh khi
man hinh hién thj kiéu hinh t6i me. Co cac
kidu 16i chdm sang:

M6t diém &nh con sang d8, luc hay lam
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I C

Hai diém anh con sang gan nhau:
Do + Lam =Tim

b6 + Luc = Vang

Luc + Lam = Luc lam (Lam nhat)

Ba diém anh con sang gan nhau (mot diém
anh tréng)

& Ghichu

Cham sang d6 hay lam phai sang hon 50%
so v&i cac chdm xung quanh trong khi cham
sang luc sang hon 30% so v&i cac chdm
xung quanh.

Cac 16i chadm den

Céc 16i cham den hién thi dwéi dang cac
diém anh hay diém anh con vén ludn téi mé
hay 't&t'. Nghia la méi chdm t6i mo la mot
diém anh con vén ndi I&n trén man hinh khi
man hinh hién thi kiéu hinh sang. C6 cac
kiéu 16i chdm den:

30

Do gan cua cac 16i diém anh

Vi céac 16i diém anh va diém anh con cta
cuing kiéu 16i vén gan véi mot kidu 16i khac
c6 thé dé nhin thay hon, Philips ciing néu rd
cac dung sai vé do gan cua 18i diém anh.

Dung sai 16i diém anh

Dé hwdng dich vu stra chiva hay thay thé do
cac 16i diém anh trong thdi han bao hanh,
man hinh monitor TFT trong man hinh phng
Philips phai c6 cac I6i diém anh hay diém
anh con vwot qua nhirng dung sai néu trong
cac bang sau.



LOI CHAM SANG

MUC CHAP NHAN

1 didm anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (m6t diém anh trang) 0
Khodang cach gitra hai I6i chAm sang* >15mm
Téng sb 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM BEN MUC CHAP NHAN

1 diém anh con t6i mo 5 hoac it hon
2 diém anh con t6i m& gan nhau 2 hoéc it hon
3 diém anh con t6i m& gan nhau 0
Khoang cach gitra hai 16i chAm den* >15mm
Téng sb 16i cham den ctia moi kiéu 16 5 hoac it hon

TONG SO LOI CHAM

Téng s6 16i chAm sang hay den ctia moi kiéu 16i

MU’'C CHAP NHAN
5 hoac it hon

© Ghichu
1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chdm

2. Man hinh nay tuan tha chuén ISO 9241-307. (IS09241-307: Yéu cau, phan tich vé hiéu
nang va cac phwong phap kiém tra tuan thd cho man hinh dién ti)
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7.2 Dich vu cham séc khach hang va bao
hanh

Dich vu cham sé6c khach hang va bao hanh

D& co thong tin chi tiét vé chinh sach bao hanh va yéu cau hd tro thém duoc p dung cho
khu vye clia ban, vui long truy cap website www.philips.com/support. Ban cling c6 thé lién
hé vé&i Trung tam cham soc khach hang dia phwong ctia Philips theo sé dién thoai dwdi day.

Théng tin lién lac cho khu vwec TAY AU:

Quéc gia ASC (Trung tam Sf“’) cham séc khach
dich vu uy quyen) hang

Austria Siemens 1&S +43 0810 000206 € 0.07
Belgium E Care +32 078 250851 € 0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0.09
Germany Siemens 1&S +49 01803 386 853 € 0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10

Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Thong tin lién lac cho khu viec TRUNG VA BONG AU:

ASC (Trung tam dich

Quéc gia  Trung tam dich vu vu ty quyn) S6 cham séc khach hang
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. |[NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
NA Serware +36 1 2426331
Hungary - -
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
RO NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
fﬂirnbt':nigm NA Kim Tec d.0.0. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Ukraine NA gms;‘;”ice +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Théng tin lién lac cho khu viec CHAU MY LATINH:

Quéc gia

Trung tam dich vu S6 chdm séc khach hang

Argentina

Vermont

0800 3330 856

Brazil

Vermont

0800-7254101

Théng tin lién lac cho khu viec NAM MY:

Qubc gia

Trung tam dich vu

ASC (Trung tam dich

S6 cham séc khach hang

Canada

Supercom

vu Uy quyén)
Supercom

(800) 479-6696

US.A.

TOS

Teleplan

(877) 835-1838

Théng tin lién lac & Trung Quéc:

Trung Quéc

Sé cham séc khach hang: 4008 800 008
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Thong tin lién lac cho khu virc Chau A TBD/Trung Béng/Chau Phi (APMEA):

Quéc gia

Trung tdam  ASC (Trung tam dich vu

dich vu

ay quyén)

S6 chiam séc khach hang

Company Ltd.

Australia NA AGOS NETWORK PTY LTD |1300 360 386
Banaladesh | NA Distributor: Computer Source | 880-2-9141747, 9127592
9 Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992
(warranty buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau e Smart Pixels Technology Ltd. |\ -\ |- Tel- (853)-0800-987
; Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4229395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 2737411-16
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
South Africa | NA Sylvara Technologies Pty Ltd | 086 0000 888
South Korea |NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d?stributor and/or service
provider currently
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand | NA ’L\t"(;s Computer System Co., | 545) 934-5498
Uaned Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LL.C
. . +84 8 38248007 Ho Chi Minh City
Vietnam NA ccsjluenpstic +84 5113.562666 Danang City

+84 5113.562666 Can tho Province
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8. Khac phuc sw c6 & Hoi
Dap

8.1 Khac phuc sw cbé

Trang nay giai quyét cac sw cb vdn nguoi
duing c6 thé khac phuc. Néu sw cb van tiép
dién sau khi ban da th&r dung céc giai phap
trén trang nay, hay lién hé v&i dai dién dich
vu khach hang cta Philips.

H Cac sw cb thwong giap

Khéng c6 hinh anh (Pén LED nguén
khéng sang)

«  Dam bao da cdm day ngudn vao & cdm
dién va mat sau ctia man hinh.

Trwéc tién, ddm bao nut ngudn & mat
trwéc man hinh ndm & vi tri OFF (TAT),
sau dé day nut sang vi tri ON (BAT).

Khéng c6 hinh anh (Pén LED nguén sang
trang)

Pam bao da bat may tinh.

Dam bao cap tin hiéu da dwoc két ndi
duang cach v&i may tinh cla ban.

dam bao cap man hinh khéng cé cac
ch&u c&m bi cong trén mat két nbi. Néu
co, hay stra hay thay m&i cap.

C6 thé da bat tinh ndng Tiét kiém nidng
lwong

Man hinh thong bao

Attention

Check cable connection

Dam bao cap man hinh da duwoc két

ndi dung cach véi may tinh cla ban.
(Ciing tham khdo Hwéng dan khéi déng
nhanh).

Ki&ém tra xem cap man hinh c6 cac chau
cam bi cong hay khong.

Dam bao da bat may tinh.

Nut AUTO (Tw dong) khéng hoat dong
Chtrc nang tw dong chi ap dung & ché
dd VGA- Analog. Néu khong hai long voi
két qua, ban c6 thé thuc hién cac didu
chinh tha c6ng qua menu OSD (hién thi
trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khong ap dung &
ché dd DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé
nhin thay

Khéng thwe hién bat ky bwéc khc phuc
sw ¢ nao

Ngét ngay két ndi man hinh khdi 6 cdm
dién chinh cho an toan

Lién hé ngay v&i dai dién dich vu khach
hang cuta Philips.

Hinh anh khéng nam giira tam man hinh
Chinh vj tri hinh dnh qua chirc nang “Auto
(Tw déng)” trong cac nat didu khién
chinh trén menu OSD.

Chinh vi tri hinh &nh qua Phase/Clock
(Géc pha/Bdng hd) clia Setup (Cai dat)
trong cac nut diéu khién chinh trén menu
OSD. N6 chi ¢6 hiéu lyc & ché do VGA.

Cac sw cd hinh anh

Hinh anh rung lén trén man hinh

Kiém tra xem cép tin hiéu da dwoc cam
chat ding cach vao bang mach db hoa
hay may tinh hay chua.

Hién thi hién twong chap chon doc
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Chinh hinh anh qua ch&c nang “Auto (Tw
dong)” trong cac nat didu khién chinh
cta menu OSD.

Loai bd céac vach doc qua Phase/Clock
(Géc pha/Ddng hd) clia Setup (Cai dat)
trong cac nut diéu khién chinh ctia menu
OSD. N6 chi ¢6 hiéu Iwc & ché do VGA.



Hién thi hién twong chap chon ngang

Chinh hinh anh qua ch&c nang “Auto (Tw
dong)” trong cac nt didu khién chinh
clia menu OSD.

Loai bd céac vach doc qua Phase/Clock
(Géc pha/Bdng hd) clia Setup (Cai dét)
trong cac nut didu khién chinh ctia menu
OSD. N6 chi ¢6 hiéu Iwc & ché do VGA.

Hinh anh hién thi nhoe, khong rd hoac
qua mo

Chinh d6 twong phan va dé sang trén
menu Hién thi trén man hinh (OSD).

Hién twong "anh ao", "anh thir néng” hay
"anh béng ma" van hién thi sau khi da tat
ngudn.

Hién thi lién tuc cac anh tinh trong mét
thoi gian dai c6 thé gay ra hién twong
"anh thir néng", con dwoc goi la “anh ao”
hay “anh béng ma”, trén man hinh cla
ban. “Anh th& néng”, “Anh &o” hay “Anh
béng ma” 1a hién twong phd bién trong
c6ng nghé man hinh monitor. Trong hau
hét cac trwong hop, hién twong “anh thir
néng” hodc “anh ao0” hay “anh bong ma”
sé& dan dan bién mé4t sau mét thoi gian
man hinh bj ngat dién.

Ludn bat trinh bdo vé man hinh chuyén
doéng khi ban khéng st dung man hinh.
Luén bat &ng dung cap nhat man hinh
dinh ky néu man hinh hién thi ndi dung
tinh khong thay dbi.

Céc hién twong “anh thir nong” hay “anh
40" hay “anh béng ma” s& khéng biét mét
va ban cadn mang man hinh di stra. Thiét
hai nhw trén khdng ndm trong chinh sach
bao hanh cua chung t6i.

Hinh hién thj bién dang. Van ban bi mo
hoac nhoe.

Cai do phan giai man hinh may tinh sang
cuing ché do véi do phan giai man hinh
gbc khuyén dung ctia man hinh LCD.

Cac cham luc, dé, lam, den va tridng hién
thi trén man hinh

Cac cham con lai 1a d&c tinh théng
thwérng ctia man hinh tinh thé 16ng dung
trong cédng nghé ngay nay. Vui long tham
kh&o chinh sach diém anh dé biét them
thong tin.

Pén “bat ngudn” qua sang va gay chéi
mét

Ban c6 thé chinh dén “bat ngudn” qua
Cai d&t dén LED ngudn trong cac nut
didu khién chinh ctia menu OSD.

.

DPé duwoc tro giup thém, hay xem danh sach
Trung tdm thong tin khach hang va lién hé
v&i dai dién dich vu cham séc khach hang
cua Philips.
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8.2 Héi dap SmartControl Lite

H1.

Pap:

H2.

bap:

Toi da déi man hinh trén PC sang
man hinh khac va khéng thé st
dung SmartControl, t6i can lam gi?

Hay khéi dong lai PC va kiém tra xem
SmartControl Lite ¢6 hoat dong khong.
Néu khéng, ban can phai g& bé va cai
dat lai SmartControl Lite dé& dam bao
cai dat driver thich hop.

Cac chlrc nang SmartControl Lite da
hoat déng tét trwéc d6, nhwng gio»
né6 khong hoat ddng nira, tdi c6 thé
lam gi?

Néu da thwc hién cac thao tac sau,

thi ban can phai cai dat lai driver man

hinh.

+ Pa ddi bo thich (rng dd hoa video
sang moét adapter khac

* Da cap nhat driver video

» Cac hoat dong trén HPBH nhw goi
hoac loat trng dung

» Chay Cap nhat Windows va cap nhat
man hinh va/hodac driver video

« D3 khéi dong Windows bang nut tat
hay ngat két néi man hinh.
D& xac dinh sy ¢b, hay click chuot
phai My Computer (May tinh cla
t6i) va click vao Properties (Thudc
tinh) -> Hardware (Phan ctng) ->
Device Manager (Quan ly thiét bi).
Néu nhin thay “Plug and Play Monitor
(Man hinh cdm vao 1a chay)” hi&én
thi trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bd
SmartControl Lite va cai dat lai.

H3.

Pap:

H4.

Dap:
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Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl Lite,
khéng c6 muc nao bat Ién sau moét
lat hodc thong bao 16i hién thi, diéu
gi da xay ra?

C6 thé Ia do bd thich trng db hoa cua
ban khéng twong thich v&i t'ng dung
SmartControl Lite. Néu b6 thich rng d6
hoa la mét trong s cac nguyén nhan
néu trén, thir tai vé driver bd thich tng
dd hoa mai nhét tir website ctia cac
cong ty twong rng. Cai dat driver. GO
bd SmartControl Lite va cai dat lai mot
l&n nira.

Néu n6 van khong hoat dong, thi rét
tiéc la bo twong twng do hoa khong
dwoc ho trg. Vui long truy cap website
ctia Philips va kiém tra xem driver _
SmartControl Lite m&i nhat da c6 san
hay chua.

Khi t6i click vao Product Information
(Théng tin san pham), né chi hién thi
moét phan, diéu gi da xay ra?

C6 thé 1a do driver bo thich ng dd hoa
clia ban khong phai la phién ban cap
nhat méi nhat vén hé tro day du giao
dién DDC/CI. Hay thir tai vé driver bd
thich (rng d& hoa m&i nhét tir website
clia cac cong ty twong &ng. Cai dat
driver. G6 bé SmartControl Lite va cai
dat lai mot 1an niva.

Attention

Theft Deterence enabled




H5. Toi da quén ma PIN cho chirc nang
Theft Deterrence (Chéng trém). Toi
can lam gi?

Pap: Trung tam dich vu Philips c6 quyén yéu
cAu xac nhan va quyén hop l& dé thiét
lap quyén s& hiru man hinh.

Xin lwu y chirc nang chong trom dwoc
cung cap nhw la tly chon tién ich mién
phi. Quan ly ma PIN la trach nhiém
riéng clia nguoi dung ca nhan hay t6
chirc von da tao ra ma nay.

Trong trwdng hop quén mé PIN, trung
tam dich vu Philips c6 thé tao lai cho
ban v&i mure phi nho sau khi xac nhan
quyen s& hiru cta ban. Xin lwu y chirc
nang nay khéng dwoc bao gom trong
cac dieu khodn bao hanh chinh thirc.



8.3 Héi bap chung

H1:

bap:

H2:

Pap:

Khi cai cai dit man hinh, t6i can lam
gi néu man hinh hién thi 'Cannot
display this video mode (Khéng thé
hién thi ché d6 video nay)'?

D6 phan giai khuyén dung cho man

hinh nay la: 1366x768@60Hz.

« Ngét t&t ca cac cap rdi két ndi PC véi
man hinh ma ban da dung trwéc dé.

» Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang diéu
khién). Trong Control Panel Window
(Clra sb bang digu khi&n), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé 'Settings
(Cai d@at)'. Trong thé cai dat, trong
0 co tén 'desktop area (vung man
hinh nén)', chuyén thanh trwot sang
1366x768 pixels

» Mé& thé 'Advanced Properties (Thudc
tinh ndng cao)' va cai Mirc cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.

Khéi dong lai may tinh va lap lai

buéc 2 va 3 dé kiém tra xem PC

clia ban da dwogc cai sang mirc
1366x768@60Hz hay chua.

« TAt may tinh, ngat két ndi man hinh
va két néi lai man hinh Philips cta
ban.

« Tét man hinh rdi bat lai PC.

Mdrc cap nhat khuyén dung cho man
hinh la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh la 60Hz. Néu c6 bét ctv hién tuwong
nhiéu nao trén man hinh, ban cé thé
cai dat murc nay sang 75Hz dé kiém tra
xem m(rc m&i nay cé loai bé dwoc hién
twong nhiéu hay khong.

H3:

Pap:

H4:

Pap:

H5:

Pap:

H6:

Pap:
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Cac file .inf va .icm trén dia CD la gi?
Lam thé nao dé cai dat cac driver (.inf
va .icm)?

bay la cac file driver cho man hinh cla
ban. Thuc hién theo cac chi dan trong
s6 tay st dung dé& cai dat cac driver
nay. May tinh c6 thé yéu cau ban cai
cac driver man hinh (file .inf va .icm)
hoé&c lap dia driver khi ban cai dat man
hinh Ian dau. Thyc hién theo cac chi
dan @& 14p (dfa CD kém theo) thiing
dwng man hinh nay. Cac driver man
hinh (file .inf va .icm) sé dwoc cai dat
tw dong.

Lam thé nao dé chinh do phan giai?

Card video/driver dd hoa cta ban va
man hinh sé ciing quyét dinh cac do
phan gidi c6 san. Ban c6 thé chon do
phan giai mong muén trong Control
Panel (Bang diéu khién) ctia Windows®
qua thé “Display properties (Thudc tinh
man hinh)”.

Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?

Chi can nhan nGt OK rdi chon 'Reset
(Cai dat lai)' d& phuc hdi moi cai dat
mac dinh géc.

Man hinh monitor c6 kha nang
chéng tray xwéc?

Noi chung ban khéng nén dé bé mét
man hinh va cham qua muc v&i cac
vat khac hay va bao vé né khai cac vat
dung séc hay cun. Khi cdm man hinh,
dam bao khong dung strc ép hay lyc
manh lén phia b& m&t man hinh. biéu
nay c6 thé anh huéng dén cac diéu
kién bao hanh cta ban.



H7: To6i nén lau man hinh monitor nhw
thé nao?

Pap: Dé lau thong thwong, hay st dung
khan sach va mém. Bé lau ky, hay
duing con isopropyl. Khéng diing cac
dung méi khac nhw cdn étylic, ethanol,
axeton, hexan, v.v...

H8: Téi c6 thé thay déi cai dat mau sic
cho man hinh?

Pap: Di nhién, ban co thé thay dbi cai dat
mau sic qua nat diéu khién trén menu
OSD theo cac quy trinh sau,

+ Nhan “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

+ Nhan “Down Arrow (Mi tén xuéng)”
d& chon tuy chon “Color (Mau)” rdi
nhén “OK” dé vao cai dat mau; c6 ba
Iwa chon mau nhw sau.

1. Nhiét d6 mau; C6 2 thiét lap la
6500K va 9300K.

2. sRGB (Dd-Luc-Lam chuén); day
Ia cai dat chuan dé& dam bao trao
ddi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); ngu&i
diing c6 thé tw chon cai dat mau
sac wu tién bang cach chinh mau
dd, luc va lam.

© Ghichu

Do mau anh sang téa ra tir mot vat dung
trong khi n6 dwoc 1am néng. S6 do nay
dwoc thé hién dwa trén ty 18 tuyét dbi, (mie
dd Kelvin). Cac mirc nhiét d6 Kevin thap
hon nhw 2004K |a mau doé; cac mire nhiét
d6 cao hon nhw 9300K Ia mau lam. Nhiét do
trung tinh la mau trdng & mic 6504K.

H9: Tai c6 thé két n6éi man hinh moi PC,
may cha hay may Mac?

DPap: Co thé. Moi man hinh Philips hoan
toan twong thich v&i cac PC, may Mac
va may chl chuén. Ban c6 thé can ¢
dAu noi cap dé két ndi man hinh mai
hé théng may Mac. Vui long lién hé voi
nhan vién kinh doanh cta Philips dé
biét thém théng tin.

H10: Man hinh Philips hd tro’ chuén Plug-

and- Play (Cam vao la phat)?

Pap: Cé, cac man hinh Philips déu hd tro
chuén Plug-and-Play twong thich véi
Windows 7/Vista/XP/NT, Mac OSX,
Linux

H11: Anh chap chon hay anh thir néng

hay anh ao hay anh béng ma trén

man hinh monitor la gi?

Pap: Hién thi lién tuc cac anh tinh trong mot

thoi gian dai c6 thé gay ra hién twong
"anh thr néng", con dwoc goi la “anh
40” hay “dnh béong ma”, trén man hinh
ctia ban. “Anh thir néng”, “Anh d0” hay
“Anh béng ma” 1a hién twong phd bién
trong cdng nghé man hinh LCD. Trong
moi trro'ng hop, hién twgng “anh thir
néng” hay “anh &o” hay “anh béng ma”
s& bién méat dan trong mot thei gian
sau khi d& t&t ngudn.
Ludn bat trinh bao vé man hinh chuyén
dong khi ban khéng st dung man hinh.
Lubn bat irng dung cap nhat man hinh
dinh ky néu man hinh hién thj néi dung
tinh khong thay dbi.

) Canh bao

Céc hién twong “anh thir nong” hay “anh ao”
hay “anh bong ma” sé& khong biét méat va ban
can mang man hinh di stva. Thiét hai nhw
trén khéng nam trong chinh sach béo hanh
cula chung toi.
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H12: Tai sao man hinh cta té6i hién thi
vin ban sic nét va cac ky tw ring
cwa?

Pap: Man hinh ctia ban hoat déng tét nhat &
do6 phan giai gbc 1366x768@60Hz. Dé
man hinh hién thj t&t nhat, vui Idng st
dung dé phan giai nay.
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